How to Configure the Workflow Service and Design the Workflow Process Templates
## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><strong>&lt;Example&gt;</strong></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, <code>F2</code> or <code>ENTER</code>.</td>
</tr>
</tbody>
</table>
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2012-11-15</td>
<td>First Version</td>
</tr>
</tbody>
</table>
| 1.1     | 2012-01-31 | • The procedures of activating the workflow user in SAP Business One (section 2.1) were simplified  
• The *Multi Instance* field was added to the *Details* section of the *Properties* window of the conventional start even element |
| 1.2     | 2013-04-09 | • Example 6 of workflow process template was added to section 4.4  
• Some fields were changed or added in the *Timer Setting* window in section 3.4.1  
• The relation between workflow processes and approval processes was added to section 4.5 |
| 1.3     | 2013-05-30 | The *Workflow Settings* window in SAP Business One Service Manager was changed in section 2.2 |
| 1.4     | 2013-08-14 | • How to run SAP Business One Studio was added to section 3.1  
• Example 7 of workflow process template was added to section 4.4 |
Table of Contents

1 Introduction .................................................................................................................................6
1.1 Workflow Function of SAP Business One ......................................................................................6
1.2 Configuring the Workflow Service and Designing Workflow Process Templates ..................................................6
   1.2.1 Configuring the Workflow Service in SAP Business One Service Manager ............................................6
   1.2.2 Designing the Workflow Process Templates in SAP Business One Studio ............................................7
1.3 Glossary .........................................................................................................................................7
1.4 Related Documentation ................................................................................................................7

2 Configuring the Workflow Service in SAP Business One Service Manager .......................................8
2.1 Activating the Workflow User in SAP Business One .......................................................................8
2.2 Configuring the Workflow Service in SAP Business One Service Manager .......................................8

3 Working with Workflow Windows in SAP Business One Studio .....................................................11
3.1 Running SAP Business One Studio ...............................................................................................11
3.2 Menu Options ................................................................................................................................11
3.3 Toolbar ..........................................................................................................................................11
3.4 Toolbox Window ..............................................................................................................................12
3.5 Properties Window ..........................................................................................................................13
   3.5.1 Properties Window for Event Elements ............................................................................................14
   3.5.2 Properties Window for Task Elements ...........................................................................................17
   3.5.3 Properties Window for Gateway Elements .......................................................................................22
   3.5.4 Properties Window for Data Object Elements ...................................................................................22
   3.5.5 Properties Window for Sequence Flows that Follow the Exclusive Gateway ..................................23
   3.5.6 Properties Window for Workflow Process .........................................................................................26

4 Working with Workflow Projects in SAP Business One Studio ..........................................................27
4.1 Creating Workflow Projects.............................................................................................................27
4.2 Opening Workflow Projects or External Files ................................................................................27
4.3 Docking Tool Windows ....................................................................................................................28
4.4 Workflow Process Template Examples ...........................................................................................28
   4.4.1 Example 1 - Create Business Partners and Update Business Partners ..................................................29
   4.4.2 Example 2 - Develop a New Customer and Provide a Sales Quotation ..............................................33
   4.4.3 Example 3 - Determining if a Sales Order Can Be Filled Without the Need to Purchase
                   More Inventory .................................................................................................................................38
   4.4.4 Example 4 - Biweekly Administration Purchase .................................................................................46
   4.4.5 Example 5 - Check Inventory Level and Transfer .............................................................................54
   4.4.6 Example 6 - Update Business Partner Information ...........................................................................57
   4.4.7 Example 7 - Approval Procedures of Adding Business Partner Master Data ......................................64
4.5 Workflow Processes and Approval Processes ..................................................................................74
4.6 Exporting the Workflow Process Templates ...................................................................................75
4.7 Adding, Renaming, Deleting, or Copying Workflow Process Templates in a Project ............................76
   4.7.1 Adding Workflow Process Templates .................................................................................................76
   4.7.2 Renaming Workflow Process Templates ..............................................................................................76
   4.7.3 Deleting Workflow Process Templates ..............................................................................................77
4.7.4 Copying Workflow Process Templates ................................................................. 77

5 Additional Information .......................................................................................... 78
5.1 Configuration File of the Workflow Service ....................................................... 78
5.2 Configuration File of Workflow Data Access ..................................................... 78

Appendix .................................................................................................................. 81
Supported SAP Business One Objects ..................................................................... 81
1 Introduction

1.1 Workflow Function of SAP Business One

Workflow is an abstraction of real business operations. It is a business process that consists of a series of connected tasks or events in sequence. It usually includes a group of tasks, the relations of the tasks, and the conditions for starting and terminating the tasks.

In SAP Business One, the workflow function enables a standard process that can be applied to a series of tasks or events for different business types in a real work environment. The workflow function provides a consolidated entry for users to process all the tasks in which they are involved. With the predefined condition, the workflow function can execute some tasks automatically in the system, so the liberated labor resource can be better allocated to increase the outcomes. It also provides management with overall control of the business process within the organization, and helps to enhance operating efficiency.

Workflow function in SAP Business One is based on the BPMN. For more information, see http://www.bpmn.org/.

1.2 Configuring the Workflow Service and Designing Workflow Process Templates

To use the workflow function in SAP Business One, you must do the following:

- Configure the workflow service in SAP Business One Service Manager
- Design the workflow process templates in SAP Business One Studio

1.2.1 Configuring the Workflow Service in SAP Business One Service Manager

You must configure the workflow service to build control over the company's databases. Through DI API, the workflow service can access the company databases and provide the information to the workflow function in SAP Business One. For more information, see the SDK online help file SDK_EN.CHM at http://service.sap.com/smb/sbocustomer/documentation.

The workflow service also ensures that the workflow instances performed in SAP Business One and the workflow process templates designed in SAP Business One Studio are matched accordingly.
1.2.2 Designing the Workflow Process Templates in SAP Business One Studio

Designing workflow process templates ensures that standard procedures are set for each type of business operation carried out in your company, for example, the purchasing process, employee reimbursement process, outgoing payment process and so on.

SAP Business One Studio provides an open platform where you can design the workflow process templates your company needs. Through a combination of the workflow elements provided in SAP Business One Studio and the property settings of these elements, the templates designed in SAP Business One Studio can widely cover actual types of business activities.

1.3 Glossary

The following terms are mentioned in this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1s</td>
<td>SAP Business One solution file</td>
</tr>
</tbody>
</table>
| BPMN | Business Process Model and Notation  
For more information, see [http://www.bpmn.org/](http://www.bpmn.org/). |

1.4 Related Documentation

The documents listed in the table are mentioned in this document.

<table>
<thead>
<tr>
<th>Document</th>
<th>Location</th>
</tr>
</thead>
</table>
| SDK online help file SDK_EN.CHM | [http://service.sap.com/smb/sbocustomer/documentation](http://service.sap.com/smb/sbocustomer/documentation) and choose Release Family 9.0 → SDK and Custom Development  
Available also on the SAP Business One product DVD and in the download package from SAP Service Marketplace |
Available also on the SAP Business One product DVD and in the download package from SAP Service Marketplace |
2 Configuring the Workflow Service in SAP Business One Service Manager

This section introduces how to configure the workflow service in the SAP Business One Service Manager.

2.1 Activating the Workflow User in SAP Business One

Procedure
1. Log on to SAP Business One as manager.
2. Set the password for user workflow.
   1. From the SAP Business One Main Menu, choose Administration → Setup → General → Users.
   2. In the Users - Setup window, find user Workflow, and in the Password field, choose (Set a Password).
      The Password window appears.
   3. In the Password window, specify and confirm the password for user Workflow.
   4. Choose the OK button.
   5. In the Users - Setup window, choose the Update button.

2.2 Configuring the Workflow Service in SAP Business One Service Manager

Prerequisites
- You have installed SAP Business One Service Manager on your server. For more information, see SAP Business One Administrator’s Guide at http://service.sap.com/smb/sbocustomer/documentation.
- You have installed DI API (32-bit) on your server to ensure that SAP Business One Service Manager (32-bit) can connect to your company database.

 Recommendation
Install the License Manager and the Workflow service on the same server.

Procedure
1. Choose Start → All Programs → SAP Business One → Server Tools → Service Manager.
2. The SAP Business One Service Manager window appears.
3. From the Service dropdown list, select Workflow and choose the Settings button.
4. The Site User Logon window appears.
5. Specify the License Server, Port and Password, and then choose the OK button.

6. The Workflow Settings window appears.

7. In the Workflow Settings window, select a database type and database server from the Database Type and Database Server dropdown lists, respectively.

8. The databases that meet the selection options are displayed in the Activate workflow for selected companies table.

9. In the Activate workflow for selected companies table, select the checkbox of the company for which you want to set the workflow function.

10. In the Password column, specify the password of user Workflow for SAP Business One. It is the new password you set in Step 7 of Activating the Workflow User in SAP Business One.
11. Choose the Test Connection button. The status of the test is displayed in the Test Connection Status column next to the relevant company.

12. Choose the OK button after the Test Connection Status column displays Pass.

13. In the SAP Business One Service Manager window, choose (Start), and then choose OK.

Note

Any time you change the specifications in the Activate workflow for selected companies table, you must do the following to restart the service:

1. In the Workflow Settings window, choose the OK button.
2. Choose (Stop).
3. Choose (Start) once the button is available.
3 Working with Workflow Windows in SAP Business One Studio

3.1 Running SAP Business One Studio

To run SAP Business One Studio, choose *All Programs → SAP Business One → SAP Business One Studio*, and choose *SAP Business One Studio*.

Alternatively, if you have an SAP Business One client installed, in SAP Business One, from the *Tools* menu, choose *SAP Business One Studio Suite*, and choose *SAP Business One Studio*.

3.2 Menu Options

The SAP Business One Studio *Menu* button is located at the top of the SAP Business One Studio main window and contains the following menu commands:

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new add-on project or a new workflow project.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing solution/project or a separate file.</td>
</tr>
<tr>
<td>Save Current File</td>
<td>Saves the current file.</td>
</tr>
<tr>
<td>Export Current File As</td>
<td>Exports the current file into the specified path. The file type is determined according to the project type. For example, you can export the current file as an .xbml file (Workflow Process file).</td>
</tr>
<tr>
<td>Save All</td>
<td>Saves the changes of all the opened files.</td>
</tr>
<tr>
<td>Recent Files</td>
<td>Shows the recently opened files.</td>
</tr>
<tr>
<td>Recent Solutions</td>
<td>Shows the recently opened solutions.</td>
</tr>
<tr>
<td>View Start Page</td>
<td>Opens or hides <em>Start Page</em>.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the SAP Business One Studio application.</td>
</tr>
</tbody>
</table>

3.3 Toolbar

The toolbar, located below the *Menu* button, is a collection of icons that provides easy access to commonly used functions. Active functions are shown in color, while inactive ones are grayed out.
### 3.4 Toolbox Window

The Toolbox window contains a collection of elements (Event, Task, Gateway, and Data Object) used to design the workflow process templates. To work with the elements, drag and drop an element on the working pane and specify the properties in the Properties window.

**Note**

For more information about using JavaScript in the workflow elements, see the .html file in the downloaded .zip file.

### Event Elements

<table>
<thead>
<tr>
<th>Event Elements</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Start Event] (Start Event)</td>
<td>Indicates the start of a workflow process manually started by the user of SAP Business One.</td>
</tr>
<tr>
<td>![Timer Start Event] (Timer Start Event)</td>
<td>Indicates the start of a workflow process automatically started in SAP Business One by the workflow service, according to the timer settings in SAP Business One Studio. It is either a one time start or a recurrent start.</td>
</tr>
<tr>
<td>![Conditional Start Event]</td>
<td>Indicates the start of a workflow process automatically started in SAP Business One by the workflow service, according to the conditional settings in SAP Business One Studio. Use JavaScript to define condition settings.</td>
</tr>
<tr>
<td>![End Event] (End Event)</td>
<td>Indicates the end of a workflow process.</td>
</tr>
<tr>
<td>![Terminate End Event]</td>
<td>Indicates the end of a multi-flow path workflow process. Once the flow path reaches this point, other flow paths are terminated automatically. The whole workflow process then is completed.</td>
</tr>
</tbody>
</table>
Task Elements

<table>
<thead>
<tr>
<th>Event Elements</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>(User Task)</td>
<td>Indicates the tasks that users need to process in SAP Business One.</td>
</tr>
<tr>
<td>(Manual Task)</td>
<td>Indicates the tasks that users process outside SAP Business One, for example, making a phone call or scheduling a meeting.</td>
</tr>
<tr>
<td>(Script Task)</td>
<td>Indicates the tasks that the workflow service processes automatically, once the conditions defined in SAP Business One Studio are met. Use JavaScript to define script tasks</td>
</tr>
</tbody>
</table>

Gateway Elements

<table>
<thead>
<tr>
<th>Event Elements</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Parallel Gateway)</td>
<td>Indicates the spot where the flow splits into multiple flow paths. Users must process each of the flow paths into which the flow splits.</td>
</tr>
<tr>
<td>(Exclusive Gateway)</td>
<td>Indicates the spot where the flow splits into several flow path options. Users only process the flow path which meets the flow conditions.</td>
</tr>
</tbody>
</table>

Data Object Elements

<table>
<thead>
<tr>
<th>Event Elements</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>(SAP Business One Data Object)</td>
<td>Indicates the Data Objects that are currently supported by the workflow function in SAP Business One.</td>
</tr>
<tr>
<td>(Customized Data Object)</td>
<td>Indicates that the Data Objects contain a series of variables necessary for the workflow service to execute the logics, such as calculating, comparing, deciding, and so on. They are usually quoted by the JavaScript specified in the Script Task or the Sequence Flow that follows the Exclusive Gateway. Customized Data Objects exist in the current workflow process only.</td>
</tr>
</tbody>
</table>

3.5 Properties Window

The Properties window lets you specify the information for the workflow elements, define the relations between the tasks, and set the conditions to start and terminate the tasks. By specifying the information and setting the conditions for the elements in the Properties window, you can design as many different workflow process templates as your company needs.

The Properties window displays different sections and fields according to the workflow element you select.
3.5.1 Properties Window for Event Elements

Properties Window

The following table displays each field that appears in the Properties window for event elements, as well as the event elements in which the fields are used.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Description</td>
<td>Specify the description for the workflow element selected.</td>
<td>All the event elements</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Specify the ID of the workflow element selected.</td>
<td>All the event elements</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Specify the name of the workflow element selected.</td>
<td>All the event elements</td>
</tr>
<tr>
<td>Details</td>
<td>Condition</td>
<td>Click to open the window to set the conditions.</td>
<td>Timer Start Event and Conditional Start Event</td>
</tr>
<tr>
<td></td>
<td>Multi Instance</td>
<td>Select whether to support multiple instances.</td>
<td>Conditional Start Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- False: a new instance can be started only after the previous instance is finished.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- True: a new instance can be started either before or after the previous instance is finished.</td>
<td></td>
</tr>
</tbody>
</table>

Note

In every General section:
- The ID field is mandatory.
- The ID of each element in the same process template must be unique.

Windows Opened from Properties Window for Event Elements

In the Details section, once you have selected the Condition field, the (Browse) button appears to the right of this field. Choosing (Browse) displays either the Timer Setting window or the Script Editor window, according to the event element you selected. You can set the conditions for the element in these windows.

Timer Setting Window

The Timer Setting window appears after you choose (Browse) to the right of the Condition field in the Timer Start Event.
In the Timer Setting window, set the conditions for the current event to start. Once the conditions meet the time settings, then in SAP Business One, the workflow service starts a workflow instance based on the workflow process template that begins with the current timer start event.

**One Time Area**

- **One Time**: Select this radio button to set the current event as a one-time start event.
- **Date**: Specify the date on which you want the current event to start.
- **Time**: Specify the time at which you want the current event to start.

**Note**

The fields in the One Time area are available only if you have selected the One Time radio button.

**Recurrent Area**

- **Recurrent**: Select this radio button to set the current event as a recurrent start event.
- **Time**: Specify the time at which you want the current event to start.
- **Range**: Specify a value in the Start field and the End field to set the time range within which you want the current event to recur.
  - **Start**: Specify the start date for the time range in which you want the current event to recur.
  - **End**: Select and specify an end type for the time range in which you want the current event to recur.
- **No End Date**: Select this radio button to set the current event as a permanent recurrent event.
- **End After <No.> Occurrences**: Select this radio button and specify the number of recurrences. The current event stops recurring after reaching the specified number of recurrences.
- **End At**: Specify the date on which you want the current event to stop recurring.

**Pattern**: From this dropdown list, select a recurrence pattern for the current event.

- **Minute**: Select this option and specify the number of minutes as the recurrence interval.
  
  Pattern: Every __________ Minutes

- **Hour**: Select this option and specify the number of hours as the recurrence interval.
  
  Pattern: Hour __________ Every __________ Hours

- **Week**: Select this option and do the following:
  - Specify the number of weeks as the recurrence interval.
  - Select a weekday on which the event recurs.
  
  Pattern: Recur Every __________ Weeks On __________

- **Month**: Select this option and do the following:
  - Specify an ordinal number; the event recurs on that number of day of the month.
  - Specify a number of months as the recurrence interval.
  
  Pattern: Day __________ Of Every __________ Months

- **Year**: Select this option and do the following:
  - Select a month and specify the date that determines the day on which the event recurs.
  - Specify a number of years as the recurrence interval.
  
  Pattern: January __________ Of every __________ Years

**Note**

The fields in the **Recurrent** area are available only if you have selected the **Recurrent** radio button.

**Script Editor Window**

The **Script Editor** window appears after you choose **Browse** to the right of the **Condition** field in the **Conditional Start Event** window.
In the *Script Editor* window, specify the conditions for the event to start. The workflow service checks the condition every ten minutes. For more information, see *Configuration File of Workflow Service*.

Once the workflow service detects the conditions that meet the specifications in the *Script Editor* window, then in SAP Business One, the workflow service starts a workflow instance based on the workflow process template that begins with the current conditional start event.

**Note**

In the *Script Editor* window, you must use JavaScript to specify the start conditions for the event.

### 3.5.2 Properties Window for Task Elements

**Properties Window**

The following table displays each field that appears in the *Properties* window for task elements, as well as the elements in which the fields are used.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Description</td>
<td>Enter a description for the selected workflow element.</td>
<td>All the task elements</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Specify the ID of the selected workflow element.</td>
<td>All the task elements</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Specify the name of the selected workflow element.</td>
<td>All the task elements</td>
</tr>
<tr>
<td>Details</td>
<td>Business Object</td>
<td>From this dropdown list, select an object to process in the task. It is the output data of the current task. This dropdown list displays all the Data Objects currently supported by the workflow function in SAP Business One, as well as the UDOs of your company.</td>
<td>User Task</td>
</tr>
<tr>
<td></td>
<td>Duration</td>
<td>Specify the length of time in which the task is allowed to complete.</td>
<td>User Task and Manual Task</td>
</tr>
<tr>
<td></td>
<td>Operation Type</td>
<td>Select an operation type for the task.</td>
<td>User Task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Add</em>: the current task is to create a new Data Object.</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Field</td>
<td>Description/Activity</td>
<td>Elements</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>-----------------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Update</strong>: the current task is to update an existing Data Object.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Participant</td>
<td>Choose this field to open new windows to specify the participants for the task.</td>
<td>User Task and Manual Task</td>
</tr>
<tr>
<td></td>
<td>Priority</td>
<td>From this dropdown list, select the priority for the task.</td>
<td>User Task and Manual Task</td>
</tr>
<tr>
<td></td>
<td>Script</td>
<td>Choose this field to open the new window to specify the conditions for the script task.</td>
<td>Script Task</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Input Object</td>
<td>User Task and Manual Task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose this field to open the new window to set the relations between the output data and the input data (input object).</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

In every **Detail** section:
- The **Participants** field is mandatory.
- The **Duration** field supports only numbers.

**Windows Opened from the Properties Window for Task Elements**

The **Details** section and the **Data** section contain fields that, once selected, display a (Browse) button to their right. Choosing (Browse) displays the relevant windows. You can specify the properties for the element in these windows.

**Connect Company Window**

Use the **Connect Company** window to connect to the database of the company for which you are designing the workflow process templates.

**Note**

To select data such as UDOs, UDFs, and company users from the company database, make sure you have installed both SAP Business One Studio and DI API in 32-bit or 64-bit.

The **Connect Company** window appears in the following tasks:
- In the **User Task**, after you choose (Browse) to the right of the **Business Object** field for the first time
  If you have any UDOs, you can select them as the business objects after you log on to your company.
- In the **User Task** or the **Manual Task**, after you choose (Browse) to the right of the **Participants** field for the first time

**Note**

If you select **Cancel** in the **Connect Company** window, the **Business Object** field only displays the SAP Business One Data Objects; the UDOs of your company cannot be displayed here.
In the `Connect Company` window, specify the information of the company from which you want to connect, and then choose the `Connect` button.

**Note**

In the `Company Name` field, you need to specify the company database name.

**Add Participants Window**

The `Add Participants` window appears after you choose the `Connect` button or the `Cancel` button in the `Connect Company` window.

Use this window to specify the participants for the task.
From the SAP Business One User dropdown list, select the participant for the task, and choose the Add button. You can add more than one participant for a task.

Note
- The participants of the tasks are the users of the company in SAP Business One.
- If you have chosen the Cancel button in the Connect Company window, the SAP Business One User dropdown list does not display any options. You can manually specify and add a user.

Script Editor Window

The Script Editor window appears after you choose Browse to the right of the Script field in the script task. In the Script Editor window, specify the conditions for the current script task. Once the workflow process reaches the script task, the workflow service automatically operates the current script task according to the specified JavaScript, and passes the flow path to the next workflow element.

Note
- In the Script Editor window, you must use JavaScript to specify the start conditions for the event.

Input Objects Editor Window

The Input Objects Editor window appears after you choose Browse to the right of the Input Object field in the User Task or the Manual Task.
In the **Input Objects Editor** window, set the relations between the output data and the input data, as follows:

- In the **Input Objects** area, select the input object for which you want to set the relations with the output data.
- In the **Expression** area, the following apply to the **Expression Type** field:
  - If you leave it blank, it means the output data is not related to the selected input data.
    
    **Expression:**
    
    **Expression Type**

  - If you select the **Command** option, the **Command Type** field appears automatically with the **Base On** option selected. It means the output data is based on the input data, and the relevant information of the input data will be displayed in the output data when you process the current task.

    **Expression:**

    **Expression Type**

    **Command Type**

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can specify more than one input object for one task.</td>
</tr>
<tr>
<td>For the <strong>User Task</strong>, each combination of options you select in the <strong>Operation Type</strong> field and in the <strong>Input Objects Editor</strong> window has different effects on the output data.</td>
</tr>
</tbody>
</table>

  The following table shows the possible combinations:

<table>
<thead>
<tr>
<th>Option Selected</th>
<th>Add Option in Operation Type</th>
<th>Update Option in Operation Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>No option in the <strong>Command Type</strong> field</td>
<td>Opens the output data without any information in it.</td>
<td>Opens the output data without any information in it.</td>
</tr>
<tr>
<td><strong>Base On</strong> option in the <strong>Command Type</strong> field</td>
<td>Opens the output data containing the relevant information copied from the input data. The input data is the base document of the output data.</td>
<td>Opens the output data containing the relevant information copied from the input data. The output data and the input data are the same type of Data Object.</td>
</tr>
</tbody>
</table>
3.5.3 Properties Window for Gateway Elements

The following table displays each field that appears in the Properties window for gateway elements.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Description</td>
<td>Specify the description for the selected workflow element.</td>
<td>Both gateway elements</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Specify the ID of the selected workflow element.</td>
<td>Both gateway elements</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Specify the name of the selected workflow element.</td>
<td>Both gateway elements</td>
</tr>
</tbody>
</table>

3.5.4 Properties Window for Data Object Elements

Properties Window

The following table displays each field that appears in the Properties window for Data Object elements.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Description</td>
<td>Specify the description for the selected workflow element.</td>
<td>Both Data Object elements</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Specify the ID of the selected workflow element.</td>
<td>Both Data Object elements</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Specify the name of the selected workflow element.</td>
<td>Both Data Object elements</td>
</tr>
<tr>
<td>Details</td>
<td>Business Object</td>
<td>From this dropdown list, select an object to use in the current Data Object.</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td></td>
<td>Key</td>
<td>Specify the key information of the business object selected.</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td></td>
<td>Customized Fields</td>
<td>Choose this field to open the new window to specify the variables that will be used later in the current process.</td>
<td>Customized Data Object</td>
</tr>
</tbody>
</table>

Window Opened from Properties Window for Data Object Elements

In the Details section, once you have selected the Customized Fields field, the (Browse) button appears to the right of this field.
Choosing \textit{(Browse)} displays the \textit{Customized Field Setting} window.

In the \textit{Customized Field Setting} window, specify the variables that need to be quoted in the current workflow process template.

\textbf{Property}: Specify the properties of the objects you want to quote in the current workflow process template.

\textbf{Type}: From this dropdown list, select the type for the default value of the specified property.

- \textit{Double}: The default value of the property is a decimal.
- \textit{String}: The default value of the property is a character string.
- \textit{Integer}: The default value of the property is an integer.

\textbf{Default Value}: Specify the value of the property.

\begin{itemize}
  \item \textbf{Add}: Choose this button to add a new property row.
  \item \textbf{Delete}: Choose this button to delete the current property row.
\end{itemize}

3.5.5 Properties Window for Sequence Flows that Follow the Exclusive Gateway

\textbf{Properties Window}

The following table displays each field that appears in the \textit{Properties} window for the \textit{Sequence Flow} that follows the \textit{Exclusive Gateway}. 

### How to Configure the Workflow Service and Design the Workflow Process Templates

#### Working with Workflow Windows in SAP Business One Studio

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Description</td>
<td>Specify the description for the selected workflow element.</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Specify the ID of the selected workflow element.</td>
</tr>
</tbody>
</table>
|         | Is Default       | - Select whether to set the current sequence flow as the default flow.  
|         |             |  
|         |             |   - **True**: Set the current flow path as the default path to process when none of the conditioned flow paths meet the process conditions. Selecting this option hides the **Detail** section.  
|         |             |   - **False**: The current flow path is not the default path to process; set the process conditions in the **Detail** section. |
|         | Name       | Specify the name of the selected workflow element. |
| Details | Condition | Click to open the window to set the conditions for processing the current flow path. |

**Window Opened from Properties Window for Sequence Flow**

In the **Details** section, once you have selected the **Condition** field, the **Browse** button appears to the right of the field.

Choosing **Browse** displays the **Condition Editor** window.

**Expression Type**: Select the type of expression in which you want to edit the conditions.

To specify the conditions for the current sequence flow, do one of the following:

- From the **Expression Type** dropdown list, select **Script Editor**; the text field appears accordingly in this window. In the text field, use JavaScript to specify the flow conditions for the sequence flow.
From the **Expression Type** dropdown list, select **Flow Condition**. From the dropdown lists, set the relevant conditions for the sequence flow.

- **Object Name**: Select the Data Object which is relevant to the conditions you want to set.
- **Property**: All the properties of the selected Data Object are listed in this dropdown list. Select the property to which the conditions you want to set are related.
- **Condition**: From the dropdown list, select the comparing condition for the value.
- **Value**: Specify the value of the selected property.
- ![Add](image) : Choose this button to add a new flow condition row.
- ![Delete](image) : Choose this button to delete the current flow condition row.

### Note
- If you select **Script Editor**, you must use JavaScript to specify the flow condition for the current sequence flow.
- In the **Property** dropdown list, you can also select any UDFs your company may have.

### 3.5.6 Properties Window for Workflow Process

#### Properties Window

The following table displays each field that appears in the **Properties** window for the current workflow process template.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td><strong>ID</strong></td>
<td>Specify the current workflow process you are designing.</td>
</tr>
<tr>
<td></td>
<td><strong>Process Description</strong></td>
<td>Specify the ID of the current workflow process you are designing.</td>
</tr>
<tr>
<td></td>
<td><strong>Process Name</strong></td>
<td>Specify the name of the current workflow process you are designing.</td>
</tr>
<tr>
<td></td>
<td><strong>Process Version</strong></td>
<td>Specify the version of the current workflow process you are designing.</td>
</tr>
</tbody>
</table>

### Note

The combination of the **ID** and the **Process Version** values defines a unique workflow process template.
4 Working with Workflow Projects in SAP Business One Studio

This section introduces how to work with the workflow projects in SAP Business One Studio.

Prerequisites
You have configured the workflow service in SAP Business One Service Manager.

4.1 Creating Workflow Projects

You can create workflow projects to design the workflow process templates.

Procedure
1. In the SAP Business One Studio main window, choose the Menu button and choose New → Project → Workflow.
   Alternatively, on the Start Page of SAP Business One Studio, choose Create Workflow.
2. In the New Project window, specify the name and location of your new project.
3. Specify the package name.
   Note: By default, the package name is the same as the project name.
   The extension of a package (SAP Business One solution) file is b1s.
4. If you need to create a project that does not contain any workflow process templates, select the Create Empty Project checkbox.
5. Choose OK.
   A new page NewProcess 1 appears in the design area of the SAP Business One Studio main window.
   You can design your workflow process template in the working pane.

4.2 Opening Workflow Projects or External Files

You can open existing workflow projects or .xbml files to edit the workflow process templates.

Procedure
1. In the SAP Business One Studio main window, choose the Menu button and choose Open → Solution/Project or Open → File.
Alternatively, on the Start Page of SAP Business One Studio, choose Open Project or Open File.

2. Specify the existing project or the file you want to open and choose Open.

   The solution hierarchy appears in the Solution Explorer window.

4.3 Docking Tool Windows

To dock the tool windows (Toolbox window, Solution Explorer window, and Properties window) to a designated area, perform the following steps:

1. Select the window you want to dock.
2. Drag the window from its current location towards the middle of the SAP Business One Studio main window.
   A guide diamond appears.
3. When the window you are dragging reaches the position where you want to dock it, move the pointer over the corresponding portion of the guide diamond and release the mouse button.

4.4 Workflow Process Template Examples

This section provides several workflow process templates and demonstrates how you can use the workflow elements to design different workflow process templates.

   Note

   For more information about detailed examples, see the .xbml files in the downloaded .zip file.

Getting Started

The three main actions listed below are needed for designing a workflow process template. They can be performed in the sequence you require:

**Select the workflow elements:**

1. In the Toolbox window, select the workflow element you need.
2. Drag the element to an appropriate position in the working pane and release the mouse button.

**Specify the information of the workflow elements:**

1. In the working pane, select the workflow element for which you want to specify the information.
2. In the Properties window of the selected element, choose different fields and specify the required information.

**Connect the workflow elements with the sequence flow:**

1. In the working pane, select the element the flow path will pass first. Several grayed out elements appear on the right side of it.
2. Click and drag the sequence flow towards the next element.
3. Drop the sequence flow after it reaches the next element.

4.4.1 Example 1- Create Business Partners and Update Business Partners

Scenario

When your company develops a new supplier, the purchase department uses the corresponding workflow template to add the business partner to the system and registers its general information. Then the finance department finds the record of this business partner and updates this record by adding the business partner’s financial information, such as credit limit, bank information, tax code and so on.

Note

The difference between example 1 and example 6:

- In the scenario of example 1, the business partner data is added by starting a workflow instance based on the corresponding workflow template.
- In the scenario of example 6, the business partner data is added directly by adding a Business Partner Master Data form to SAP Business One.
To design a workflow process template for this scenario, specify the properties for the elements as follows:

**For the task "Add BP":**

In this task, the staff of the purchase department needs to add a business partner master data record and enter the general information for this supplier in SAP Business One.

Specify the task properties as follows:
From the Business Object field, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.

Do not specify the Input Object field in the Data section, since this task does not have input data.

For Data Object 1:

Data Object 1 is the output data of task "Add BP", it is also the input data of task "Update BP".

Specify the properties of this Data Object as follows:

From the Business Object dropdown list, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.

For the task "Update BP":

In this task, the staff of the finance department needs to update the business partner master data for this supplier in SAP Business One by adding the financial information of this supplier to the record.

Specify the task properties as follows:
Note

- From the Business Object dropdown list, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.
- From the Operation Type dropdown list, select Update. The purpose of this task is to update an existing Data Object.

You must set the relation between the input data and the output data, so the relevant information will be linked to the business partner master data when you process the task.

Specify the input object of this task as follows:

For Data Object 2:

Data Object 2 is the output data of task “Update BP”.

Specify the properties of this Data Object as follows:
From the Business Object dropdown list, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.

4.4.2 Example 2 - Develop a New Customer and Provide a Sales Quotation

Scenario

Your company gets a sales opportunity from a new customer. The sales department calls the customer to acquire basic information and learn the needs of the customer.

Next, the sales department records this customer in the system and confirms with the warehouse that they have the inventories the customer needs.

Finally, your company generates a sales quotation for this customer.
Process Image

Element Used in the Current Example

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Start Event and End Event</td>
</tr>
<tr>
<td>Task</td>
<td>User Task and Manual Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td>Gateway</td>
<td>Parallel Gateway</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow</td>
</tr>
</tbody>
</table>

Workflow Element Properties

To design a workflow process template for this scenario, specify the properties for the elements as follows:

For the task "Make a Call":

In this task, the sales department talks to the new customer by phone to acquire basic information and learn the needs of the customer.

This is a manual task which you do not process in SAP Business One.

Specify the properties of this task as follows:
For the Parallel Gateway:

The parallel gateway indicates where the flow path diverges or converges. In this example, the process splits into two flow paths at the first parallel gateway; these two flow paths are parallel to each other. The users must process both of them. The second parallel gateway waits for both of the flow paths to converge at this point, and then the process flows to the next workflow element.

For the task "Add BP":

In this task, the sales department needs to add a business partner master data record and enter the general information for this new customer in SAP Business One.

Specify the task properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data</strong></td>
</tr>
<tr>
<td>Input Object:</td>
</tr>
<tr>
<td><strong>Details</strong></td>
</tr>
<tr>
<td>Business Object:</td>
</tr>
<tr>
<td>Duration:</td>
</tr>
<tr>
<td>Operation Type:</td>
</tr>
<tr>
<td>Participant:</td>
</tr>
<tr>
<td>Priority:</td>
</tr>
<tr>
<td><strong>General</strong></td>
</tr>
<tr>
<td>Description:</td>
</tr>
<tr>
<td>ID:</td>
</tr>
<tr>
<td>Name:</td>
</tr>
</tbody>
</table>

Note

From the Business Object dropdown list, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.

For Data Object 1:

Data Object 1 is the output data of task "Add BP", it is also the input data of task "Quotation".
Specify the Data Object properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Object</td>
</tr>
<tr>
<td>Business Object Key</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>

Form the **Business Object** dropdown list, select **BusinessPartners**. **Business Partner Master Data** is one of the Data Objects supported by the workflow function in SAP Business One.

**For the task “Check Inventory”:**

In this task, the sales department needs to confirm with the warehouse that the goods the customer needs are in stock.

This is a manual task which you do not process in SAP Business One.

Specify the task properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Object</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
</tr>
<tr>
<td>Participants</td>
</tr>
<tr>
<td>Priority</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>

**For the task “Quotation”:**

In this task, the sales department needs to generate and add a sales quotation in SAP Business One based on the agreement with this customer.

Specify the task properties as follows:
From the Business Object field, select Quotations. Sales Quotation is one of the Data Objects supported by the workflow function in SAP Business One.

From the Operation Type dropdown list, select Add. The purpose of this task is to generate a Data Object based on an existing one.

In this task, the operation is to generate a quotation based on an existing business partner master data. You must set the relation between the input data and the output data, so the relevant information will be linked to the quotation when you process this task.

Specify the input object of this task as follows:

For Data Object 10:

Data Object 10 is the output data of task "Quotation".

Specify the Data Object properties as follows:
From the Business Object field, select Quotations. Sales Quotation is one of the Data Objects supported by the workflow function in SAP Business One.

### 4.4.3 Example 3 - Determining if a Sales Order Can Be Filled Without the Need to Purchase More Inventory

**Scenario**

Your company receives a purchase order from the customer. The sales manager asks to check if there is enough inventory, and then executes one of the following orders:

- If there is enough inventory, make the delivery to the customer.
- If there is not enough inventory, purchase to replenish the stock.
Process Image

Element Used in the Current Example

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Start Event and End Event</td>
</tr>
<tr>
<td>Task</td>
<td>User Task and Script Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object and Customized Data Object</td>
</tr>
<tr>
<td>Gateway</td>
<td>Exclusive Gateway</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow and Sequence Flow after Exclusive Gateway</td>
</tr>
</tbody>
</table>

Workflow Element Properties

To design a workflow process template for this scenario, specify the properties for the elements as follows:

For the task “Sales Order”:
In this task, the manager needs to generate and add a sales order in SAP Business One.
Specify the task properties as follows:
Note

- Form the Business Object dropdown list, select Orders. Sales Order is one of the Data Objects supported by the workflow function in SAP Business One.
- Do not specify the Input Object field in the Data section, since this task does not have input data.

For Data Object OR1:

Data Object OR1 is the output data of task “Sales Order”, it is also the input data of task “Delivery”.

Specify the Data Object properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Object</td>
</tr>
<tr>
<td>Business Object Key</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>

From the Business Object dropdown list, select Orders. Sales Order is one of the Data Objects supported by the workflow function in SAP Business One.

For the task "Need to Purchase":

For the sales item in the current task, the workflow service checks the following:

- The sales quantity specified in the current task
- The quantity in stock

The workflow service compares the check results. If the quantity in stock is less than the sales quantity, the current task defines the value of the variable “needPurchase” as “1”.

Choose the Script field to open the Script Editor window. Specify the JavaScript as follows:
Note
You must use JavaScript to edit the script task.

Recommendation
Use JavaScript to perform logics such as comparing, calculating, judging, and so on. Overly complicated logic may cause performance issues, for example, SQL queries or transactions that take a long time to execute.

For the Customized Data Object "do2":
In this customized Data Object, the variable is "needPurchase". By default, the value of this variable is "0".
Specify the Data Object properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>

Choose the **Customized Fields** field to open the **Customized Field Setting** window. Specify the customized fields as follows:

<table>
<thead>
<tr>
<th>Customized Field Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**For the Sequence Flows that Follow the Exclusive Gateway:**

The exclusive gateway indicates where the process splits into more than one flow path; each sequence flow that follows the exclusive gateway has a flow condition. Every time the process reaches the exclusive gateway, the workflow service checks the value of a specified variable or property and compares it with the flow conditions. The process only flows to the sequence flow for which the conditions are met.

**The Sequence Flow Between the Exclusive Gateway and Task “Delivery”:**

This sequence flow is the default flow path to process when none of rest flow paths meet the process conditions. Specify the properties of this sequence flow as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**The Sequence Flow Between the Exclusive Gateway and Task “Purchase Order”:**

For this sequence flow, the flow condition is: the value of the variable "needPurchase" is equal to "1". This means that when the value of the variable "needPurchase" is "1", the process flows to task "Purchase Order". Specify the properties of this sequence flow as follows:
Choose the **Condition** field to open the **Condition Editor** window. Specify the flow condition as one of the following:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details</strong></td>
</tr>
<tr>
<td><strong>Condition</strong></td>
</tr>
<tr>
<td><strong>General</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>ID</strong></td>
</tr>
<tr>
<td><strong>Is Default</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
</tbody>
</table>

**Note**
- If you choose **Script Editor** as the expression type, you must use JavaScript to edit the flow condition.
- If your company has any UDFs, you can use it/them in the JavaScript, or select it/them from the **Property** dropdown list.

**For the task “Delivery”:**

In this task, the warehouse needs to add a delivery document in SAP Business One and deliver the goods to the customer.

Specify the task properties as follows:
Form the Business Object dropdown list, select DeliveryNotes. Delivery is one of the Data Objects supported by the workflow function in SAP Business One.

From the Operation Type dropdown list, select Add. The purpose of this task is to generate a Data Object based on an existing one.

In this task, the operation is to generate a delivery based on an existing sales order. You must set the relation between the input data and the output data, so the relevant information will be linked to the delivery when you process this task.

Specify the input object of this task as follows:

For Data Object 3:

Data Object 3 is the output data of task "Delivery".

Specify the Data Object properties as follows:
Form the Business Object dropdown list, select DeliveryNotes. Delivery is one of the data objects supported by the workflow function in SAP Business One.

For the task "Purchase Order":

In this task, the relevant employees need to add a purchase order in SAP Business One and purchase some goods from the supplier.

Specify the task properties as follows:

```
Properties

- Business Object: PurchaesOrders

- Duration

- Operation Type: Add

- Participant: "P001"

- Priority: Medium

- Description: Purchase Order

- ID: userTask3

- Name: Purchase Order
```

Note

Form the Business Object dropdown list, select PurchaesOrders. Purchase Order is one of the Data Objects supported by the workflow function in SAP Business One.

For Data Object 4:

Data Object 4 is the output data of task "Purchase Order".

Specify the Data Object properties as follows:
Form the Business Object dropdown list, select PurchasesOrders. Purchase Order is one of the Data Objects supported by the workflow function in SAP Business One.

4.4.4 Example 4 - Biweekly Administration Purchase

Scenario

As of 08/30/2012, the administration department of your company purchases office supplies every two weeks. Most of the suppliers are big firms; however, one supplier, with the code V001, is a small grocery store that cannot issue invoices.

The purchase order is always issued to the suppliers at 10 am on Monday, and the goods are delivered to your company during the week.

- If the supplier is not V001, ask the supplier for the invoice and pass it on to the A/P accountant to create an A/P invoice.
- If the supplier is V001, take no further action.

The purchase process is then finished.
To design a workflow process template for this scenario, specify the properties for the elements as follows:

**For the Timer Start Event:**

In this scenario, the purchase process takes place every two weeks. The purchase order is always issued to the suppliers at 10 am on a Monday.

Specify the event properties as follows:

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Timer Start Event, End Event and Terminate End Event</td>
</tr>
<tr>
<td>Task</td>
<td>User Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td>Gateway</td>
<td>Exclusive Gateway</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow and Sequence Flow after Exclusive Gateway</td>
</tr>
</tbody>
</table>
Specify the timer settings of this task as follows:

For the task "Purchase Order":

In this task, the administration manager needs to add a purchase order in SAP Business One for the items that are in short supply.

Specify the task properties as follows:
Note
- From the Business Object field, select PurchaseOrders. Purchase Order is one of the Data Objects supported by the workflow function in SAP Business One.
- Do not specify the Input Object field in the Data section, since this task does not have input data.

For Data Object 1:
Data Object 1 is the output data of task "Purchase Order", it is also the input data of task "Goods Receipt". Specify the Data Object properties as follows:

From the Business Object dropdown list, select PurchaseOrders. Purchase Order is one of the Data Objects supported by the workflow function in SAP Business One.

For the task "Goods Receipt":
In this task, when the goods are delivered to your company, the administration assistant compares the goods with the purchase order and generates a goods receipt PO in SAP Business One.
Specify the task properties as follows:
From the Business Object dropdown list, select PurchaseDeliveryNotes. Goods Receipt PO is one of the Data Objects supported by the workflow function in SAP Business One.

From the Operation Type dropdown list, select Add. The purpose of this task is to generate a Data Object based on an existing one.

In this task, the operation is to generate a goods receipt PO based on an existing purchase order. You must set the relation between the input data and the output data, so the relevant information will be linked to the goods receipt PO when you process this task.

Specify the input object of this task as follows:

For Data Object 4:

Data Object 4 is the output data of task "Goods Receipt", it is also the input data of task "A/P Invoice".

Specify the Data Object properties as follows:
From the Business Object dropdown list, select PurchaseDeliveryNotes. Goods Receipt PO is one of the Data Objects that SAP Business One supports.

For the Sequence Flows that Follow the Exclusive Gateway:

The exclusive gateway indicates where the process splits into more than one flow path; each sequence flow that follows the exclusive gateway has a flow condition. When the process reaches the exclusive gateway, the workflow service checks the value of a specified variable, and compares it with the flow conditions. The process only flows to the sequence flow for which the condition is met.

The Sequence Flow Between Task “Goods Receipt” and the Terminate End Event:

For this sequence flow, the flow condition is: the code of the supplier in task “Purchase Order” is “V001”. This means that when the supplier in “Purchase Order” is “V001”, the process flows to the terminate end event.

Specify the properties of this sequence flow as follows:

Choose the Condition field to open the Condition Editor window. Specify the flow condition as one of the following:
Note

- If you choose Script Editor as the expression type, you must use JavaScript to edit the flow condition.
- If your company has any UDFs, you can use it/them in the JavaScript, or select it/them from the Property dropdown list.

The Sequence Flow Between Task "Goods Receipt" and Task "A/P Invoice"

This sequence flow is the default flow path to process when none of rest flow paths meet the process conditions. Specify the properties of this sequence flow as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Is Default</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>

For the task "A/P Invoice":

In this task, the A/P accountant needs to get the invoice from the supplier and add an A/P invoice in SAP Business One.

Specify the task properties as follows:
From the Business Object dropdown list, select *PurchaseInvoices*. *A/P Invoice* is one of the Data Objects supported by the workflow function in SAP Business One.

From the Operation Type dropdown list, select *Add*. The purpose of this task is to generate a Data Object based on an existing one.

In this task, the operation is to generate an A/P invoice based on an existing goods receipt PO. You must set the relation between the input data and the output data, so the relevant information will be linked to the A/P invoice when you process this task.

Specify the input object of this task as follows:

For Data Object 5:

Data Object 5 is the output data of task "A/P Invoice".

Specify the properties of this Data Object as follows:
From the Business Object dropdown list, select PurchaseInvoices. A/P Invoice is one of the Data Objects supported by the workflow function in SAP Business One.

4.4.5 Example 5 - Check Inventory Level and Transfer

Scenario

Your company wants to build an inventory checking and transferring system. The system checks the quantity of the inventory in warehouse 02, and whenever the quantity is less than 100, the main warehouse transfers inventories to warehouse 02 to replenish the stock.

Process Image
Element Used in the Current Example

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Conditional Start Event and End Event</td>
</tr>
<tr>
<td>Task</td>
<td>User Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow</td>
</tr>
</tbody>
</table>

Workflow Element Properties

To design a workflow process template for this scenario, specify the properties for the elements as follows:

For the Conditional Start Event:

In this scenario, define a condition to check the quantity of the inventory in warehouse 02. Whenever the quantity of the inventory falls below 100, the process starts.

Specify the event properties as follows:

```
Choose the Condition field to open the Script Editor window. Specify the JavaScript as follows:

var param = company.getRecordsetParams();
var query = "select * from OITW where WnsCode = 02 and OnHand < 100"
//print(query);
param.setQuery(query);
var recordset=company.getRecordset();
recordset.doQuery(param);
recordset.read() > 0;
```

Ok  Cancel
Note

- You must use JavaScript to edit the script task.
- The start of a conditional event depends on the return value of the codes. The event starts only if the return value of the codes is "true".

For the task "Stock Transfer":

In this task, the staff of the main warehouse needs to add an inventory transfer in SAP Business One, so as to transfer the inventory to warehouse 02.

Specify the task properties as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
</tr>
<tr>
<td>Input Object</td>
</tr>
<tr>
<td>Details</td>
</tr>
<tr>
<td>Business Object</td>
</tr>
<tr>
<td>Duration</td>
</tr>
<tr>
<td>Operation Type</td>
</tr>
<tr>
<td>Participant</td>
</tr>
<tr>
<td>Priority</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>

Note

- From the Business Object dropdown list, select StockTransfer. Inventory Transfer is one of the Data Objects supported by the workflow function in SAP Business One.
- Do not specify the Input Object field in the Data section, since this task does not have input data.

For Data Object 1:

Data Object 1 is the output data of task "Stock Transfer".

Specify the properties of this Data Object as follows:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
</tr>
<tr>
<td>Business Object</td>
</tr>
<tr>
<td>Business Object Key</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
</tbody>
</table>
From the Business Object dropdown list, select Stock Transfer. Inventory Transfer is one of the Data Objects supported by the workflow function in SAP Business One.

4.4.6 Example 6 - Update Business Partner Information

Scenario

After the business partner data is added to the system, further actions need to be taken by other departments to complete or update this data.

For example, the finance controller needs to convene a credit analysis meeting for each new customer obtained, to determine their credit information, such as credit terms, early payment discount, bulk purchase discount and so on. Then the relevant credit information needs to be added to the system to complete the business partner data.

Note

The difference between example 1 and example 6:
- In the scenario of example 1, the business partner data is added by starting a workflow instance based on the corresponding workflow template.
- In the scenario of example 6, the business partner data is added directly by adding a Business Partner Master Data form to SAP Business One.
Element Used in the Current Example

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Conditional Start Event and End Event</td>
</tr>
<tr>
<td>Task</td>
<td>Script Task and User Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object and Customized Data Object</td>
</tr>
<tr>
<td>Gateway</td>
<td>Exclusive Gateway</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow and Sequence Flow After Exclusive Gateway</td>
</tr>
</tbody>
</table>

Prerequisites

Your company has added the UDF "isNew" to the Business Partner Master Data window in SAP Business One. Specify the UDF data as follows:

![Field Data](image)
Workflow Element Properties

To design a workflow process template for this scenario, specify the properties for the elements as follows:

For the Conditional Start Event:

In this scenario, when a new business partner master data is added directly to SAP Business One, a workflow instance based on this process template starts.

By default, the workflow service checks every 10 minutes for any newly added business partner master data to determine whether a new instance needs to be started. You can change the time interval for the workflow service to check this condition. For more information, see Configuration File of the Workflow Service.

Specify the event properties as follows:

Choose the **Condition** field to open the **Script Editor** window. Specify the start conditions as follows:

```
var param = company.getRecordsetParam();
var query = "select crdcode from OCRO where U_isNew = 'Y' "
print(query);
param.setQuery(query);
var recordset = company.getRecordset();
recordset.doQuery(param);
recordset.read() > 0;
```

1. **Note**
   - You must use JavaScript to edit the script task.
   - The start of a conditional event depends on the return values of the codes. The event starts only if the return value of the codes is “true”.
For the task "Check New BP":

In this task, the workflow service checks if there is any newly added business partner master data. If there is no new data detected, the current task defines the value of the variable "NoNewBPs" as "-1".

Choose the Script field to open the Script Editor window. Specify the JavaScript as follows:

```javascript
var param = company.getRecordsetParams();
var query = "select cardcode from OCRD where U_isNew = 'Y'";
print(query);
param.setQuery(query);
var recordset = company.getRecordset();
recordset.doQuery(param);
if (recordset.read()) {
    var field = recordset.getField(0);
    var cardName = field.getColumnName();
    var cardCode = field.getValue();
    print("cardCode = " + cardCode);
    CurrentProcess.DataObject('dataObject26').putItem('Key', cardCode);
}
//update
var query1 = "update OCRD set U_isNew='N' where cardcode = " + cardCode + ";";
print(query1);
param.setQuery(query1);
var recordset1 = company.getRecordset();
recordset1.doQuery(param);
}
else {
    CurrentProcess.DataObject('dataObject27').putItem('NoNewBPs', '-1');
}
```

Note

You must use JavaScript to edit the script task.

Recommendation

Use JavaScript to perform logics such as comparing, calculating, judging, and so on. Overly complicated logic may cause performance issues, for example, SQL queries or transactions that take a long time to execute.

For the Customized Data Object 27:

In this customized data object, the variable is "NoNewBPs". By default, the value of this variable is "0".

Specify the data object properties as follows:
Choose the Customized Fields field to open the Customized Field Setting window. Specify the customized fields as follows:

For the Sequence Flows that Follow the Exclusive Gateway:

The exclusive gateway indicates where the process splits into more than one flow path; each sequence flow that follows the exclusive gateway has a flow condition. Every time the process reaches the exclusive gateway, the workflow service checks the value of a specified variable or property and compares it with the flow conditions. The process flows only to the sequence flow for which the flow conditions are met.

The Sequence Flow Between the Exclusive Gateway and the End Event:

For this sequence flow, the flow condition is: the value of the variable "NoNewBPs" is "-1". This means that when the value of the variable "NoNewBPs" is "-1", the process flows to the end event, and the whole workflow process then finishes.

Specify the properties of this sequence flow as follows:
Choose the **Condition** field to open the **Condition Editor** window. Specify the flow condition as follows:

![Condition Editor](image)

**The Sequence Flow Between the Exclusive Gateway and Task "Create a Meeting for New BP"**

This sequence flow is the default flow. This means when none of the other flow paths meet their flow conditions, the process flows to the task "Create a Meeting for New BP".

Specify the properties of this sequence flow as follows:

![Properties](image)

**For the task "Create a Meeting for New BP":**

In this task, the finance controller needs to convene a credit analysis meeting for the customer obtained, to determine the credit information to be granted to the customer.

Specify the task properties as follows:
Note

From the Operation Type dropdown list, select Add. The purpose of this task is to generate a Data Object based on an existing one.

In this task, the activity is based on a newly added business partner master data. You must set the relation between the input data and the output data, so the relevant information is linked to the output data when you process this task.

Specify the input object of this task as follows:

For the Data Object 28:
Data Object 28 is the input data of task "Create a Meeting for New BP".
Specify the data object properties as follows:
From the Business Object dropdown list, select BusinessPartners. Business Partner Master Data is one of the Data Objects supported by the workflow function in SAP Business One.

For Data Object 26:
Data Object 26 is the output data of task "Create a Meeting for New BP". Specify the data object properties as follows:

From the Business Object dropdown list, select Activities. Activities is one of the Data Objects supported by the workflow function in SAP Business One. In addition, set the current activity as a meeting, as needed.

4.4.7 Example 7 - Approval Procedures of Adding Business Partner Master Data

Scenario

According to the internal control requests of a company, employees cannot add new business partner data to the system without the approval of management. Senior employees or managers need to check or verify the information before approving the addition of new business partners to the system.

In this example, user Michael is in charge of entering business partner information into the system, while user Richard is responsible for reviewing the information. Richard decides whether a business partner should be approved, or whether the business partner should be rejected and returned to Michael for revision or further completion.
Element Used in the Current Example

<table>
<thead>
<tr>
<th>Workflow Element Type</th>
<th>Elements Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Start Event and End Event</td>
</tr>
<tr>
<td>Task</td>
<td>User Task and Script Task</td>
</tr>
<tr>
<td>Data Object</td>
<td>SAP Business One Data Object</td>
</tr>
<tr>
<td>Gateway</td>
<td>Exclusive Gateway</td>
</tr>
<tr>
<td>Sequence Flow</td>
<td>Regular Sequence Flow and Sequence Flow after Exclusive Gateway</td>
</tr>
</tbody>
</table>

Prerequisites

You have granted appropriate authorizations for business partner master data to both user Michael and user Richard.

- Michael can add business partner master data to the system for further approval, but he cannot change the status of the business partner master data. In order to do so, he needs authorization to add new business partner master data to the system, and he cannot have authorization for the following:
  - Setting **Active** as the status of Business Partner Master Data
  - Setting **Inactive** as the status of Business Partner Master Data

Set Michael's authorizations as follows:
In order to approve or reject the business partner master data, Richard needs authorization for the following:
  - Adding new Business Partner Master Data to the system
  - Setting *Active* as the status of Business Partner Master Data
  - Setting *Inactive* as the status of Business Partner Master Data

Set Richard’s authorizations as follows:
Workflow Element Properties

To design a workflow process template for this scenario, specify the properties for the elements as follows:

For the task "Add BP":

In this task, Michael needs to create a new business partner master data and add it to the system.
Specify the task properties as follows:

![Task Properties](image)

Note

Do not specify the Input Object field in the Data section, since this task does not have input data.

For Data Object 1:

Data Object 1 is the output data of task "Add BP"; it is also the input data of both task "Approve BP" and task "Update BP".

Specify the Data Object properties as follows:

![Data Object Properties](image)

For the task "Change BP to Inactive":

In this task, for any business partner master data added by Michael, SAP Business One changes its status to "Inactive" automatically.

This "Inactive" status triggers the start of the next task in which Richard determines whether to approve or reject the business partner master data.
Choose the **Script** field to open the **Script Editor** window. Specify the JavaScript as follows:

```
var BPCode = CurrentProcess.B1Obj('dataObject1');
var bpService = company.getBusinessService('2');
var bp = company.getBusinessObject('2', BPCode.getCode());
var frozenType = Utility.getEnumValue(bp, 'FrozenType', 'YES');
var validType = Utility.getEnumValue(bp, 'ValidType', 'NO');
bp.setFrozen(frozenType);
bp.setValid(validType);
bpService.update(bp);
```

**Note**

You must use JavaScript to edit the script task.

**Recommendation**

Use JavaScript to perform logics such as comparing, calculating, judging, and so on. Overly complicated logic may cause performance issues, for example, SQL queries or transactions that take a long time to execute.

**For the task "Approve BP":**

In this task, Richard checks the business partner master data that flows to him. He can do one of the following:

- **Approve:**
  
  If the business partner master data added by Michael is correct and complete for approval, in the **Business Partner Master Data** window, Richard changes the status of the current record from "Inactive" to "Active", and chooses the **Update** button in this window.

- **Reject:**
  
  If the business partner master data added by Michael cannot be approved, in the **Business Partner Master Data** window, Richard enters some comments or requests in the **Remarks** field on the **General** tab, and chooses the **Update** button in this window.

Specify the task properties as follows:
Note

From the Operation Type dropdown list, select Update. The purpose of this task is to update an existing Data Object.

You must set the relation between the input data and the output data, so the relevant information will be linked to the business partner master data which you will process in this task.

Specify the input object of this task as follows:

For Data Object 2:

Data Object 2 is the output data of task "Approve BP".

Specify the Data Object properties as follows:
For the Sequence Flows That Follow the Exclusive Gateway:

The exclusive gateway indicates where the process splits into more than one flow path; each sequence flow that follows the exclusive gateway has a flow condition. Every time the process reaches the exclusive gateway, the workflow service checks the value of a specified variable or property and compares it with the flow conditions. The process only flows to the sequence flow for which the conditions are met.

The Sequence Flow Between the Exclusive Gateway and the End Event:

For this sequence flow, the flow condition is: the value of property "Frozen" for Data Object 2 is "tNO". This means for Data Object 2, when the value of its property "Frozen" is "tNO", the process flows to the end event.

From the business logic view, this means that if Richard has approved the business partner master data Michael added, then the whole process is finished. In other words, during task "Approve BP", in SAP Business One, if Richard has changed the status of the business partner master data to "Active", the process then flows to the current sequence flow, and the whole process is finished accordingly.

Specify the properties of this sequence flow as follows:

Choose the Condition field to open the Condition Editor window. Specify the flow condition as one of the following:
Note
If you choose Script Editor as the expression type, you must use JavaScript to edit the flow condition.

The Sequence Flow Between the Exclusive Gateway and the Task "Update BP":
This sequence flow is the default flow path to process when none of the remaining flow paths meet the process conditions.
From the business logic view, this means that if Richard has rejected the business partner master data Michael added, then the process flows to task "Update BP". In other words, during task "Approve BP", in SAP Business One, if Richard has added some comments or requests without changing the status of this business partner master data, the process then flows to the current sequence flow, and the whole process flows to the next task.
Specify the properties of this sequence flow as follows:

For the task "Update BP":
In this task, Michael needs to update the business partner master data, add further information or correct the wrong information and resubmit for Richard’s approval.
Specify the task properties as follows:
You must set the relation between the input data and the output data, so the relevant information will be linked to the business partner master data which you will process in this task.

From the **Operation Type** dropdown list, select **Update**, and specify the input object of this task as follows:

**For Data Object 3:**

Data Object 3 is the output data of task "Update BP". It is also the input data of task "Approve BP".

Specify the Data Object properties as follows:
## Process Summary in SAP Business One

<table>
<thead>
<tr>
<th>Workflow Processes</th>
<th>Operations to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Task &quot;Add BP&quot;</td>
<td>In SAP Business One, Michael opens the <em>Business Partner Master Data</em> window, specifies the information for BP C001 and chooses the <em>Add</em> button. Due to Michael’s authorization, he cannot change the status of business partner C001.</td>
</tr>
<tr>
<td>2. Task &quot;Change BP to Inactive&quot;</td>
<td>According to the JavaScript specified in this task, SAP Business One changes the status of business partner C001 to &quot;Inactive&quot; automatically.</td>
</tr>
<tr>
<td>3. Task &quot;Approve BP&quot;</td>
<td>To approve: In SAP Business One, Richard opens the <em>Business Partner Master Data</em> window of C001, changes its status to &quot;Active&quot;, and chooses the <em>Update</em> button. <strong>To reject:</strong> In SAP Business One, Richard opens the <em>Business Partner Master Data</em> window of C001, enters some comments or changes any of the information in this window, and chooses the <em>Update</em> button.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>o You cannot change the status of business partner C001. Otherwise the system takes this record as approved.</td>
</tr>
<tr>
<td></td>
<td>o We suggest you enter your comments in the <em>Remarks</em> field on the <em>General</em> tab.</td>
</tr>
<tr>
<td>4. Exclusive Gateway</td>
<td>In SAP Business One Service Manager, the workflow service checks the status of business partner C001.</td>
</tr>
<tr>
<td></td>
<td>• If the status is &quot;Active&quot;, the process flows to the end event, and the whole process is finished.</td>
</tr>
<tr>
<td></td>
<td>• If the status is &quot;Inactive&quot;, the process flows to task &quot;Update BP&quot;.</td>
</tr>
<tr>
<td>5. Task &quot;Update BP&quot;</td>
<td>In task &quot;Approve BP&quot;, if Richard has rejected business partner C001, the process flows to this task. In SAP Business One, Michael opens the <em>Business Partner Master Data</em> window of C001, whom Richard has rejected. Michael updates or completes the information in this window, and chooses the <em>Update</em> button.</td>
</tr>
<tr>
<td>6. Task &quot;Approve BP&quot;</td>
<td>In SAP Business One, Richard opens the <em>Business Partner Master Data</em> window of C001 and checks the information again. If the information is correct and complete now, he changes the status of the business partner to &quot;Active&quot;, and chooses the <em>Update</em> button in the window. The whole process is then finished.</td>
</tr>
</tbody>
</table>
4.5 Workflow Processes and Approval Processes

Workflow process enables a standard process that can be applied to a series of tasks or events for certain types of operation to be achieved in a real business environment.

Approval process is used where the standard work procedure requires an approval from a manager or senior member before employees can generate certain marketing documents. For more information, see the Approval Process section in the Online Help.

The workflow process and the approval process are two individual functions which do not conflict with each other. The following example can walk you through how the workflow process and the approval process work with each other.

Scenario

![Workflow Process Diagram]

Prerequisites

*Sales Order* is set to a document that requires the approval process.

Procedures

<table>
<thead>
<tr>
<th>Procedures</th>
<th>Description</th>
<th>Tasks/Documents Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Workflow Process</td>
<td>Starts the workflow instance.</td>
<td></td>
</tr>
<tr>
<td>2. Workflow Process</td>
<td>The participant picks up task “Production Orders”.</td>
<td>To be Picked → In Process</td>
</tr>
<tr>
<td></td>
<td>The participant processes task “Production Orders”.</td>
<td>In Process → Completed</td>
</tr>
<tr>
<td>3. Workflow Process</td>
<td>The participant picks up task “Sales Orders”.</td>
<td>To be Picked → In Process</td>
</tr>
<tr>
<td></td>
<td>The participant processes task “Sales Orders”.</td>
<td>In Process → In Process</td>
</tr>
<tr>
<td>4. Approval Process</td>
<td>The <em>Sales Order</em> triggers the approval process. A draft document of <em>Sales Order</em> is created by the originator in</td>
<td>Draft Document</td>
</tr>
</tbody>
</table>
How to Configure the Workflow Service and Design the Workflow Process Templates

Working with Workflow Projects in SAP Business One Studio

Error! Reference source not found.

© 2013 SAP AG. All rights reserved.

75

Procedures | Description | Tasks/Documents Status
--- | --- | ---
| | task "Sales Orders", waiting for approval. In the Output Data table of the Task Details window, the number of the draft document is displayed in the Code column. | |
| | The authorizer approves the draft document. | Regular Document

5. Save Draft Document | Add the approved draft document to the system. In the Output Data table of the Task Details window, the number of the regular document is displayed in the Code column. | In Process ➔ Completed

6. Workflow Process | The participant picks up task "Delivery". | To be Picked ➔ In Process

7. Workflow Process | The participant processes task "Delivery ". | In Process ➔ Completed

4.6 Exporting the Workflow Process Templates

After you finish designing a workflow process in SAP Business One Studio, you must export it as an .xbml file, and then import the .xbml file into SAP Business One as a workflow template.

Procedure

1. In the toolbar, click Export.
2. The Save window appears.
3. In the Save window, specify the location to which to export the .xbml file.
4. Specify the name for the .xbml file and choose the Save button.

After exporting the template, instead of modifying the template in SAP Business One Studio, you can modify it by modifying the content of the .xbml file.

Recommendation

In the .xbml file, modify only the parameters of the templates. Modifying the structures of the template in the .xbml file may cause errors in the template.

To modify the structures of the workflow process templates, use SAP Business One Studio.

1. Note
   - When the document processed in the task is a draft document, in the Output Data table of the Task Details window, the number of the draft document is displayed in the Code column.
   - When the document processed in the task is a regular document, in the Output Data table of the Task Details window, the number of the regular document is displayed in the Code column.
4.7 Adding, Renaming, Deleting, or Copying Workflow Process Templates in a Project

You can use the Solution Explorer window to add, rename, delete, or copy workflow process templates for your project.

4.7.1 Adding Workflow Process Templates

You can add new or existing processes to a workflow project.

**Adding New Workflow Process Templates to the Project**

To add new process templates to your project, in the Solution Explorer window, right-click the project and choose New Process. A new process page appears in the Solution Explorer window. You can now design the new workflow process template.

**Adding Existing Workflow Process Templates to the Project**

The following procedure lets you add existing process templates to your project.

**Procedure**

1. In the Solution Explorer window, right-click the project and choose Add Existing Process. The Add Existing Item window appears.
2. Select the .xbml file you want to add, and choose the Open button. The workflow process template appears in the Solution Explorer window.

4.7.2 Renaming Workflow Process Templates

The following procedure lets you rename the workflow process templates in your project.

**Procedure**

1. In the Solution Explorer window, right-click a workflow process template, and choose Rename.
2. Specify the new name for the process template, and press Enter on your keyboard. The new name of the workflow process template appears in the Solution Explorer window.
4.7.3 Deleting Workflow Process Templates

The following procedure lets you delete workflow process templates in your project.

Procedure

1. In the **Solution Explorer** window, right-click a workflow process template, and choose *Delete*.
   
   A **System Message** window appears to inform you the process will be deleted.
2. Choose the **OK** button.
   
   The workflow process template disappears from the **Solution Explorer** window.

4.7.4 Copying Workflow Process Templates

The following procedure lets you copy the workflow process templates in your project.

Procedure

1. In the **Solution Explorer** window, right-click the workflow process template you want to copy, and choose *Copy*.

2. In the **Solution Explorer** window, right-click the project to which you want to copy the workflow process templates, and choose *Paste*.

   Note

   You can paste the workflow process template to the current workflow project, or you can open another workflow project and paste the workflow process template there.
5 Additional Information

5.1 Configuration File of the Workflow Service

The configuration file of the workflow service is where the settings of the workflow service are defined. To view this file, navigate to ...

```xml
<?xml version="1.0" encoding="utf-8"?>
<WorkflowManagerConfig xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" DBServerPath="pqv50821378a" DBType="dst_MSSQL2008" JavaXmxOption="512m" CondEventStartInterval="10">
  <CompanyDBs>
    <CompanyDBConfig DBName="workflow_test" Password="AQQAAANGMh48EFdEJRjoAWE/C1+sBAAAY91sBTvEN01DnqmW1n9YoAQAAAAACAAAAA#x1; &x1;AJAD2gAAwAAAAAAAADDg1d2fEgCDLm6YJ5sAAAAAASSAAACgAAAAA8AAJ1P&x0; &x1;vSYS0gh9gE4Wzh230VQAAAAA8fBp/6HglpBgMlsnxnOOrQAAA9L9QIIw3Qmd7&x0; &x1;8vV2ja5MAJAQAQ---&x0; &x1;"/>
  </CompanyDBs>
  <DIIDSetting Address="127.0.0.1" Port="61179"/>
  <LogConfig Info="0" Err="1" Warn="1" Debug="1" MaxFileSize="5" C:\Program Files (x86)\SAP\SAP Business One ServerTools\Workflow\Log\WorkflowEngine.log</LogConfig>
</WorkflowManagerConfig>
```

- In the JavaXmxOption attribute, the value of 512m means the default value of the maximum Java heap size is 512m. You can modify this value as needed.
- In the CondEventStartInterval attribute, the value of 10 means that by default, the workflow service checks the conditions defined in the conditional start events every 10 minutes to see if any instances need to be started. You can modify this value as needed.

5.2 Configuration File of Workflow Data Access

The configuration file of the workflow service is where the settings of workflow data access are defined. Workflow data access serves as a bridge that connects the workflow service and the company databases.
To view this file, navigate to ...

SAP\SAP Business One Server\Tools\Workflow\SBO_WorkflowDataAccess.exe.config

```xml
<configuration>
  <configSections>
    <sectionGroup name="applicationSettings" type="System.Configuration.ApplicationSettingsGroup, System, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
    <section name="DIWebKitInstance.Properties.Settings" type="System.Configuration.ClientSettingsSection, System, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false" />
  </sectionGroup>
</configSections>

<DIWebKitInstance.Properties.Settings>
  <setting name="AutoEndTransactionDuration" serializeAs="String">
    <value>00:03:00</value>
  </setting>
  <setting name="MemoryThresholdMB" serializeAs="String">
    <value>1024</value>
  </setting>
  <setting name="IdleThresholdMinute" serializeAs="String">
    <value>30</value>
  </setting>
  <setting name="EnableSSL" serializeAs="String">
    <value>True</value>
  </setting>
  <setting name="DomainName" serializeAs="String">
    <value></value>
  </setting>
</DIWebKitInstance.Properties.Settings>
</configuration>
```

- The workflow service creates a transaction to communicate with the company databases whenever it needs to process or execute the logics. By default, if the idle time of the transaction is more than three minutes, the workflow service ends the current transaction and starts a new one.

To change the default transaction restart time, modify the value in the following `value` tag.

```xml
<setting name="AutoEndTransactionDuration" serializeAs="String">
  <value>00:03:00</value>
</setting>
```

- Once the workflow service starts to process or execute the logics, the workflow data access creates a working process for each company you have activated in SAP Business One Service Manager. For more information, see Configuring the Workflow Service in SAP Business One Service Manager.

By default, when the memory of the working process reaches 1024m, the workflow data access creates a new working process to replace it.
To change the default threshold memory of the working process, modify the value in the following `value` tag:

```xml
<setting name="MemoryThresholdMB" serializeAs="String">
  <value>1024</value>
</setting>
```

- Once the workflow service starts to process or execute the logics, the workflow data access creates a working process for each company you have activated in SAP Business One Service Manager. For more information, see Configuring the Workflow Service in SAP Business One Service Manager.

  By default, if the working process is idle for more than 30 minutes, the workflow service ends the current process and starts a new one.

To change the default threshold memory of the working process, modify the value in the following `value` tag:

```xml
<setting name="IdleThresholdMinute" serializeAs="String">
  <value>30</value>
</setting>
```
## Appendix

### Supported SAP Business One Objects

The following table shows the data objects that are currently supported by the workflow function in SAP Business One.

<table>
<thead>
<tr>
<th>Data Object Name in DI API</th>
<th>Window Name in SAP Business One</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activities</td>
<td>Activity</td>
</tr>
<tr>
<td>BankChargesAllocationCodes</td>
<td>Bank Charges Allocation Codes</td>
</tr>
<tr>
<td>BillOfExchangeTransactions</td>
<td>Bill of Exchange Transactions</td>
</tr>
<tr>
<td>BusinessPartner</td>
<td>Business Partner Master Data</td>
</tr>
<tr>
<td>CorrectionInvoice</td>
<td>A/R Correction Invoice</td>
</tr>
<tr>
<td>CorrectionInvoiceReversal</td>
<td>A/R Correction Invoice Reversal</td>
</tr>
<tr>
<td>CorrectionPurchaseInvoice</td>
<td>A/P Correction Invoice</td>
</tr>
<tr>
<td>CorrectionPurchaseInvoiceReversal</td>
<td>A/P Correction Invoice Reversal</td>
</tr>
<tr>
<td>CashDiscounts</td>
<td>Cash Discount</td>
</tr>
<tr>
<td>CreditNotes</td>
<td>A/R Credit Memo</td>
</tr>
<tr>
<td>DeliveryNote</td>
<td>Delivery</td>
</tr>
<tr>
<td>Deposits</td>
<td>Deposit</td>
</tr>
<tr>
<td>DownPaymentInvoices</td>
<td>A/R Down Payment Invoice</td>
</tr>
<tr>
<td>DownPaymentRequests</td>
<td>A/R Down Payment Request</td>
</tr>
<tr>
<td>DunningTerms</td>
<td>Dunning Terms</td>
</tr>
<tr>
<td>IncomingPayments</td>
<td>Incoming Payments</td>
</tr>
<tr>
<td>InventoryGenEntry</td>
<td>Goods Receipt</td>
</tr>
<tr>
<td>InventoryGenExit</td>
<td>Goods Issue</td>
</tr>
<tr>
<td>InventoryTransferRequest</td>
<td>Inventory Transfer Request</td>
</tr>
<tr>
<td>Invoices</td>
<td>A/R Invoice</td>
</tr>
<tr>
<td>Item</td>
<td>Item List - Selection Criteria</td>
</tr>
<tr>
<td>JournalEntries</td>
<td>Journal Entry</td>
</tr>
<tr>
<td>JournalVouchers</td>
<td>Journal Vouchers</td>
</tr>
<tr>
<td>LandedCosts</td>
<td>Landed Costs</td>
</tr>
<tr>
<td>Data Object Name in DI API</td>
<td>Window Name in SAP Business One</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>MaterialGroups</td>
<td>Material Groups - Setup</td>
</tr>
<tr>
<td>MaterialRevaluation</td>
<td>Inventory Revaluation</td>
</tr>
<tr>
<td>Order</td>
<td>Sales Order and Purchase Order</td>
</tr>
<tr>
<td>ProductionOrder</td>
<td>Production Order</td>
</tr>
<tr>
<td>ProductTrees</td>
<td>Bill of Materials</td>
</tr>
<tr>
<td>PurchaseCreditNotes</td>
<td>A/P Credit Memo</td>
</tr>
<tr>
<td>PurchaseDeliveryNotes</td>
<td>Goods Receipt PO</td>
</tr>
<tr>
<td>PurchaseDownPaymentInvoices</td>
<td>A/P Down Payment Invoice</td>
</tr>
<tr>
<td>PurchaseDownPaymentRequests</td>
<td>A/P Down Payment Request</td>
</tr>
<tr>
<td>PurchaseInvoices</td>
<td>A/P Invoice</td>
</tr>
<tr>
<td>PurchaseOrders</td>
<td>Purchase Order</td>
</tr>
<tr>
<td>PurchaseQuotations</td>
<td>Purchase Quotation</td>
</tr>
<tr>
<td>PurchaseReserveInvoices</td>
<td>A/P Reserve Invoice</td>
</tr>
<tr>
<td>PurchaseReturns</td>
<td>Goods Return</td>
</tr>
<tr>
<td>Quotations</td>
<td>Sales Quotation</td>
</tr>
<tr>
<td>ReserveInvoices</td>
<td>A/R Reserve Invoice</td>
</tr>
<tr>
<td>Return</td>
<td>Return</td>
</tr>
<tr>
<td>SalesForecasts</td>
<td>Forecasts</td>
</tr>
<tr>
<td>SalesOpportunities</td>
<td>Sales Opportunity</td>
</tr>
<tr>
<td>ServiceCalls</td>
<td>Service Call</td>
</tr>
<tr>
<td>StockTransfer</td>
<td>Inventory Transfer</td>
</tr>
<tr>
<td>User</td>
<td>Users - Setup</td>
</tr>
<tr>
<td>VendorPayments</td>
<td>Outgoing Payments</td>
</tr>
<tr>
<td>WizardPaymentMethods</td>
<td>Payment Methods</td>
</tr>
</tbody>
</table>
Material Number

© 2013 SAP AG. All rights reserved.
No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG.
The information contained herein may be changed without prior notice.
Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.
Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.
IBM, DB2, DB2 Universal Database, System i, System p, System z, System x, System z10, System z9, pSeries, sSeries, xSeries, eServer, z/VM, z/OS, z/EO, S/390, OS/390, OS/400, AS/400, S/390 Parallel Enterprise Server, PowerVM, Power Architecture, POWER6+, POWER6, POWER5+, POWER5, POWER, OpenPower, PowerPC, BatchPipes, BladeCenter, System Storage, GPFS, HACMP, RETAIN, DB2 Connect, RACF, Redbooks, OS/2, Parallel Sysplex, MVS/ESA, AIX, Intelligent Miner, WebSphere, Netfinity, Tivoli and Informix are trademarks or registered trademarks of IBM Corporation.
Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Oracle is a registered trademark of Oracle Corporation.
UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.
Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.
HTML, XML, XHTML, and W3C are trademarks or registered trademarks of W3C*. World Wide Web Consortium, Massachusetts Institute of Technology.
Java is a registered trademark of Sun Microsystems, Inc.
JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.
SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.
These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies (“SAP Group”) for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.